

NAFED
60 Years of Service
e-Tender notice for supply of Light Weight Jute Sacking Bags (Indian Origin -775 gms) Jute Bags for Packing of Oilseeds
NAFED invites e-Tender from reputed empanelled Jute-Mills for supply of New Light Weight Jute Sacking Bags (Indian Origin-775 gms) Gunny Bags for onward despatch to various State Civil Supply Corporation/State Level Agency etc. Only Jute Mills is allowed to participate in the e-Tender for supply of Gunny Bags.
Empanelled Jute Mills can submit their bids till 03.05.2024 up to 2:00 PM at MSTC site. e-Tender finalization will be carried out on the same day at 03:00 PM along with matching with L1 rates will be finalised through e-mail communication wherein tenderers will be provided a fixed time window to provide the confirmation on the same keeping in loop with M/s. MSTC.

e-Tender terms & conditions can be obtained from NAFED website as well as M/s. MSTC portal on payment of Rs. 5000/- per form + GST @ 18%. Empanelled Bidders can download the e-Tender terms & conditions from NAFED website www.nafed-india.com as well as mstcecommerce.com. The e-Tender fees (non-refundable) of 5000 INR, (Five Thousand only) + GST @ 18% by means of DD/ Pay Order has to be made in favour M/s. NAFED before submitting their bids in the e-Tender. Empanelled bidders have to pay the tender fee on or before the last date of submission of bids otherwise it shall be treated as rejected. Further a demand draft for Rs. 30,00,000.00 (Rs. Thirty Lakhs Only) in favour of NAFED payable at Kolkata towards earnest money should be submitted at the time of submission of e-Tender. No adjustment will be made against previously submitted EMD. MSME will be exempted from tender fee and EMD on submission of the documents in this regard.  However, MSME will have to deposit security amount of Rs. 30,00,000.00 (Rs. Thirty Lakhs only) when they are awarded order for supply of gunny bags. 
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1. SCHEDULE OF TENDER (SOT): 
	a.
	MODE OF TENDER
	E Tender no.: ________________
e-tender System by Online Part I - Techno- Commercial Bid and Online Part II - Price Bid through https://www.mstcecommerce.com/eproc/

	b.
	Notice available for parties to view
	From 26.04.2024

	c.
	Last date and time of remittance of Tender Fee 
	03.05.2024 up to 02:00 PM

	d.
	Last Date for deposition/ Remittance of EMD amount
	
03.05.2024 up to 02:00 PM

	e.
	Start date and time of submission of online Techno-Commercial Bid and price	Bid at https://www.mstcecommerce.com/eproc/
	26.04.2024 at 10:00 AM

	f.
	Last date and time of submission of online Techno-Commercial Bid and price Bid	at https://www.mstcecommerce.com/eproc/
	03.05.2024 up to 02:00 PM

	g.
	Matching with L1 rates through e-mail communication (In case there is no reverse auction)
	To be communicated later









2. Important instructions for e-procurement 

Bidders are requested to read the terms & conditions of this tender before submitting their online tender.
1.	Process of E-tender:
A) Registration: The process involves vendor’s registration with MSTC e-procurement portal which is free of cost. Only after registration, the vendor(s) can submit his/their bids electronically. This submission of bids shall be done over the internet. The Vendor should possess a valid Class III signing and encryption type digital signature certificate. Vendors are to make their own arrangement for bidding from a computer connected with Internet. MSTC is not responsible for making such arrangement. (Bids will not be recorded without Digital Signature).
SPECIAL NOTE: THE PRICE BID HAVE TO BE SUBMITTED ON-LINE ATwww.mstcecommerce.com/eproc
i. Vendors are required to register themselves online with https://www.mstcecommerce.com/eproc → Register (Filling up details and creating own user id and password) → Submit. Please follow the ‘Registration Guide’ available in the Registration link before proceeding.
ii. Vendors will receive a system generated mail confirming the registration in their email which has been provided during filling the registration form.
iii. The Vendors shall have to subscribe to the buyers and categories in order to receive system generated mails. In order to subscribe, a vendor has to login and click on ‘My Subscription’ followed by ‘Add Subscription’. On successful subscription, a system generated mail shall be forwarded to the vendor. Please follow the guide for ‘Subscription’ of ‘Download Guides’ available in the Dashboard before proceeding.
For specific queries/ clarifications, please contact MSTC
Contact person (MSTC Ltd):
HELPDESK Numberfor any technical assistance– 033 23400020/21/22, 033 35013220/21/22
1. Mr. Sabyasachi Mukherjee, Manager, ERO, Mobile No. 7278030407 email: smukherjee@mstcindia.co.in
2. Mr. K Kranthi Kumar , Asst. Manager, ERO, Mobile No: 9174009882,  email :kkkumar@mstcindia.co.in

B. System Requirement:
a) Operating System –Windows 7 and above 
b) Web Browser- Preferred ‘IE 8’ and above. 
c) Security Settings:  
i) Tools=>Internet Options=>Security=>Disable protected Mode If enabled-i.e., Remove the tick from the box mentioning “Enable Protected Mode”. 
ii) Tools => Internet Options => Security =>Custom Level=>
· Active X control & plug-ins: Enable all Active-X Controls  
· Scripting: Enable “Allow Status Bar Update Via Script”
· Disable “Use Pop-up Blocker” 
 d) Java: JRE 8 Latest update 
e) Other Settings: 
i) View => Toolbars=> “Tick” Status Bar. 
ii) Tools=>Internet Options=> General=> Click on Settings under “Browsing history/Delete Browsing History”=> Temporary Internet Files=>Activate “Every time I Visit the Webpage”. 
f) For new Version of IE or other “Active –X Filtering” under Tools should not be ticked. 
g) Tools =>Internet Options=> Security=> Selected Trusted Sites=> Add Website http://www.mstcecommerce.com. 
2.	The tender will be opened electronically on specified date and time as given in the NIT.
3.	All entries in the tender should be entered in online Price Bid Formats without any ambiguity.
4.	All notices and correspondence to the bidder(s) shall be sent by email only during the process, up to the finalization of tender by MSTC. Hence the bidders are required to ensure that their official email ID provided is valid and updated at the stage of registration of vendor with MSTC (i.e.ServiceProvider).BiddersarealsorequestedtoensurevalidityoftheirDSCs(DigitalSignature Certificates).
5. E-tender cannot be accessed after the due date and time.



6. Bidding in e-tender:
a. The process involves Electronic Bidding for submission of Bid.
b. The bidder(s) can submit their Bid through internet in MSTC Website www.mstcecommerce.com/eproc
c. The NIT/ Documents shall be available for download in the event catalogue available under ‘Event Details’ of the Event.
d. Please follow the guides for ‘Uploading encryption public key’ and ‘Bidding’ under ‘Download Guides’ available in the Dashboard before proceeding to submit bid.
e. The bidders may upload the bidding related documents in the link ‘My Documents’. The documents uploaded here shall be available for attaching with this event in the Bid Floor.
f. In order to submit bid, a vendor has to go to ‘Events’ from the menu and select ‘Bid Floor’. The vendor has to select the buyer ‘MSTC Limited’ from the buyer list in order to view the live events list.  The correct event has to be selected from the event list for participation. A vendor has to submit ‘Event wise bid details’ that may consist of ‘Pre Qualification Criteria’, ‘Common Terms’ and/ or ‘Document Attach’. A vendor has to save the Pre Qualification Criteria, Common Terms and/ or attach documents by clicking the respective buttons. Once the event specific bids are saved, the status is updated in ‘Event specific bid status’ and the ‘Item specific bid’ button appears on the bid floor. Thereafter vendor has to click button under ‘Technical Cover’ in order to save the technical bid for specific lots. Once the technical bid is saved, the ‘Price Cover’ button appears on the screen for respective lots. Once price bid is saved, the vendor has to click on ‘Final Submit’. On final submission of bid, the status of the bid submission shall display ‘Bid submitted’ under ‘Item specific bid status’. A vendor shall receive system generated mail. 
NOTE: - The bid cannot be revised once the Final Submit button has been clicked by the bidder. However, if the bidder wishes to change his bids then he may delete the bid and re- submit the same.
g. In all cases, bidder should use their own ID and Password along with Digital Signature at the time of submission of their bid.
h. During the entire e-tender process, the bidders will remain completely anonymous to one another and also to everybody else.
i. The e-tender floor shall remain open from the pre-announced date & time and for the duration mentioned above.
j. All electronic bids submitted during the e-tender process shall be legally binding on the bidder. Any bid will be considered as the valid bid offered by that bidder and acceptance of the same by MSTC Ltd will form a binding contract between MSTC Ltd and the Bidder.
k. 	It is mandatory that all the bids are submitted with digital signature certificate otherwise the same will not be accepted by the system.
l. With due consent of NAFED officials, M/s. MSTC Ltd reserves the right to cancel or reject or accept or withdraw or extend the tender in full or part as the case may be without assigning any reason thereof.
No deviation of the terms and conditions of the tender document is acceptable. Submission of bid in the e-tender floor by any bidder confirms his acceptance of terms & conditions for the tender.
m. Unit of Measure (UOM)is indicated in the e-tender Floor. Rate to be quoted should be in Indian Rupee as per UOM indicated in the e-tender floor/tender document.
7.	Any order resulting from this e-tender shall be governed by the terms and conditions mentioned therein.
8.	No deviation to the terms & conditions are allowed.
9.	With due consent of NAFED officials, M/s. MSTC Ltd has the right to cancel this e-tender or extend the due date of receipt of bid(s) without assigning any reason thereof.
10.	The online tender should be submitted strictly as per the terms and conditions and procedures laid down in the website www.mstcecommerce.com/eprochome/mstc of MSTC Ltd.
11	The bidders should upload all the documents required (if any) as per terms of NIT. Any other document uploaded which is not required as per the terms of the NIT shall not be considered.
12.	The bid will be evaluated based on the filled-in Price bid formats.
13.	Canvassing in any form in connection with the Tender is strictly prohibited and the bids submitted by the bidders who resort to canvassing are liable to be rejected.
14. The bid will be evaluated based on the filled-in technical & commercial formats. All the L1 Bid/Bids received against any lot shall be considered irrespective of the “Best Deal” tag displayed in the system.
Only those Bidders who are found to be eligible in accordance with the prescribed eligibility conditions and whose bids meet the requirements under this Tender Document shall be declared as the “Technically Qualified Bidders”.

The Lowest price offer amongst the Technically Qualified Bidders shall be the floor price for the reverse e-auction.
The Technically Qualified Bidders shall be ranked on the basis of the ascending price bid offer submitted by them. On the basis of such ranking the Technically Qualified Bidders, holding first fifty per cent of the ranks (with any fraction rounded off to higher integer) or the top five Technically Qualified Bidders, whichever is higher, shall be considered to be qualified for participating in the reverse e-auction (the “Qualified Bidders”). Intimation shall be restricted only to the Qualified Bidders. 

Provided also that in the event of identical initial price offers being submitted by two or more Technically Qualified Bidders, all such Technically Qualified Bidders shall be assigned the same rank for the purposes of determination of qualified bidders and in such case, the aforementioned fifty per cent shall stand enhanced to fifty per cent plus the number of Technically Qualified Bidders, whose initial price offers are identical less the number of such identical initial price offers.
Illustration:
(i) In the event there are a total of ten Technically Qualified Bidders, and each Technically Qualified Bidders submits different initial price offer, then the Technically Qualified Bidders holding the first fifty per cent of ranks (with any fraction rounded off to higher integer) or five whichever is higher shall be considered to be Qualified Bidders.
(ii) In the aforementioned case, if three Technically Qualified Bidders submit the same initial price offer and are ranked in first fifty per cent of the total number of ranks, then all the three Technically Qualified Bidders shall be considered to be Qualified Bidders and the total number of Qualified Bidders shall stand increased by two. NAFED is not obliged to provide any explanation or clarification on their disqualification to Bidders who fail to qualify as Technically Qualified Bidders.

Reverse e-auction

In Case of a Tie in L-1 Prices, the tender shall be followed by reverse auction among qualified bidders:

In the reverse e-auction, the Qualified Bidders may submit their final price offers which shall be a lower than the Floor Price. The Final Price Offer may be revised till the conclusion of the e-auction.
(b) The e-auction process shall be annulled if none of the Qualified Bidders submits a Final Price Offer on the reverse e-auction. In case the e-auction process is annulled due to non-submission of at least one Final Price Offer on the electronic auction platform, the Bid Security of the Qualified Bidder(s) who has submitted the lowest Initial Price Offer in the e-tender mentioned above shall be forfeited in accordance.

(c) The Qualified Bidder who submits the lowest Final Price Offer shall be declared as the “L1 Bidder” immediately on conclusion of the e-auction.

Conduct of reverse e-auction

Reverse e-auction is the process of inviting binding Final Price Offer(s) from Qualified Bidders through internet for the purpose of determination of the L1 Bidder. During this process, the Qualified Bidder will be able to submit its Final Price Offer as many times as it wishes against the same Lot. The Qualified Bidder will remain anonymous to other Qualified Bidders participating in the electronic auction process as well as to e-auction platform provider/ NAFED. The Qualified Bidder will be able to see the prevailing lowest Final Price Offer against the Lot but the name of the lowest Qualified Bidder at any point of time will not be displayed. The Qualified Bidder shall have to put its Final Price Offer lower and below the displayed lowest bid by a minimum increment of Rs 1 to become the Lowest Qualified - Bidder.

The electronic auction process will have a scheduled start and close time which will be displayed on screen. A Qualified Bidder will be able to put its Final Price Offer after the start of bid time and till the close time of electronic auction. The current server time (IST) will also be displayed on the screen. In the event a Final Price Offer is received during the last 10 (Ten) minutes before the scheduled close time of electronic auction, the close time of electronic auction will be automatically extended by 10 (Ten) minutes from the last received bid time to give equal opportunity to all other Qualified Bidders. This process of auto extension will continue till no Final Price Offer is received during a period of 10 (Ten) minutes. For example, assuming that the initial scheduled close time for a particular electronic auction is 1:00 pm and a Final Price Offer is received at 12:55 pm, the scheduled close time shall be revised to 1:05 pm. Again if a Final Price Offer is received at 1:01 pm, the scheduled close time shall be revised to 1:11 pm and so on. In the event that no further Final Price Offer is received till 1:11 pm, the electronic auction will close at 1:11 pm. The revised close time will be displayed on screen and the Qualified Bidders are advised to keep refreshing its webpage to get the latest information. The above example is only illustrative and meant for explaining the e-auction process only. During the process of electronic auction, the Bidder shall be required to sign their bids with their respective digital signature certificate (DSC) and the use of which has been duly authorised on behalf of the Bidder and which was used at the time of registration. Any digital signature certificate other than the above shall not be acceptable for bid submission by the system. Bidders in their own interest are advised to get themselves acquainted with the electronic auction process of e-auction platform provider by getting their Authorised Representative trained beforehand through some demo electronic auctions.











Detailed Terms and conditions of the BID
A.  Scope of supply:
1. Light Weight Jute Sacking Bags Gunny bags i.e. Indian origin as per new BIS specification IS 18161: 2023 (91.00 cm* 67.50 cm, Weight 775 gms) for Mustard seeds Packing. There should be no spillage from the filled bag during the normal handling/ transit etc. 

Note: BIS test methods shall be applicable:
1. 3 Ply Heracles stitches are mandatory for Light Weight Jute Sacking Bags (775 gms) bags.
2. Three blue stripes should be present in each and every bags.
3. Safety Stitches shall be provided at the inner edges of herakle stitches.
4. Transportation for supply of gunny bags to various State Level Agencies/State Civil Supply Corporation etc. has to be arranged by the Jute Mills
5. JC empaneled inspection agencies will be appointed by NAFED, and inspection will be carried out at a particular mill by different agencies on rotations basis. 

B. Quantity &Branding:

Bulk quantity of new Light Weight Jute Sacking Bags 775 gms may be required for onward dispatches to various State Marketing Federations/State Level Agency etc. for packing of Oilseeds to be procured under PSS Scheme of Govt of India.

Jute bags should be strictly marked with “Manufactured in India “as per the Gazetted notification of Ministry of Textiles vide notification dated 15.01.2020 under reference no. S.O. 533(E) which shall be applicable to our tender terms and conditions. Further, the mill name should be printed in each and every Light weight Jute Sacking Bags 775 gms bags. In addition to this branding may be different as per the consignee requirement and the same will be intimated while issuance of work order.

The quantity mentioned in the work order to the successful Jute Mills would be purely indicative and not guaranteed and quantity can be decreased/ increased/ abolished by the purchaser. 
C. Delivery Period:

The gunny bags are to be supplied within prescribed time period from the date of placement of work order for supply by NAFED. The delivery should be done 70% against the offered	quantity by May 2024 and remaining 30% should be completed by mid-June 2024 and as per the requirement of the consignee. Accordingly quantity must be offered and supply should be ensured.
D. 	Rate quotation:

The bags are required to be delivered to consignee centre point by transportation and after duly checking the quality by reputed inspection agency. The basic rates per 100 bags F.O.R destination quoted shall be inclusive of branding charges, transit insurance of goods, statutory taxes, transit cost, inspection, loading & Unloading (at godown point), supervision charges, 2nd stage handling charges & NAFED administrative charges. Empanelled Jute Mills shall have to take transit insurance of the Gunny bags being sent to various consignees. Bill shall be raised by supplier/ empanelled jute mills in favour of consignee inclusive at approved F.O.R rate. 
NAFED will raise a separate administrative charges i.e., 1.50 % plus GST @ 18% on the jute mills for various consignees at a time for a particular crop season. 
1. Jute Mills need to bid for a minimum quantity of 25 Lakhs pcs in total without any bifurcation and NAFED Kolkata branch reserves the right to place the work order according to the requirement of Consignee.
2. The work orders issued to different jute mills w.r.t e-Tender dated 06.02.24 must be supplied first and further offered quantity for new e-tender should be submitted as per the mill capacity (Type-A category) and the new jute mill participants should submit their offer quantity as per their mill capacity (Type-A category).

E.	e-Tender Fee:

e-Tender fees of Rs. 5000/- + GST @ 18 %in the form of DD/ Pay Order in favour of “NAFED” payable at Kolkata shall have to be deposited in this office within the scheduled time i.e. before commencement of e-Tender in the M/s. MSTC portal, as mentioned in the Tender Notice. e-Tender without tender fees as referred above, shall not be accepted. However, MSME is exempted from submission of e-tender fee.
F.        E.M.D:
An EMD of Rs. 30,00,000/- (Thirty Lakhs only) is to be deposited in the form of DD/ RTGS in favour of “NAFED”. REFUND of EMD: The EMD of unsuccessful tenderer shall be refunded after final acceptance of tender of successful bidder. EMD so deposited shall not accrue any interest. However, as per law, MSME is exempted from submitting EMD for any tender. This amount of Rs. 30 lakhs will be treated as security deposit instead of EMD. Tender without EMD, shall not be accepted. However, MSME is exempted from submitting EMD with tender.

G.	E-Way bill :

	Jute Mills have to submit E-Way bill along with consignment note. 

H.	Security:

EMD deposited by the successful bidder shall be treated as security deposit. Such security deposit shall be refunded after successful execution of the order. If the supplier fails to supply the quantity as per order& e-Tender conditions, the security deposit shall be liable to be forfeited and the supplier may be black listed as per the decision of the branch. MSME Jute mill are required to deposit security of Rs. 30 lakhs after awarding of Tender.
I.	Inspection:
The inspection of goods shall be carried out by the JC empanelled inspection house appointed by the NAFED to ascertain the quality of material primarily. Inspection will be carried out at a particular empanelled Jute mill for Indian Origin bags by different agencies on rotations basis. The Surveyor shall be appointed by NAFED and surveyor charges shall be borne by the Jute mills. The inspection shall be carried out before loading into trucks. The report of inspection so carried out shall form the part of dispatch intimation, in lack of which the consignment may be rejected. However in case of any recommendation by consignee for inspection of bags out of JC empanelled agencies, that may be followed.
J.	Payment term:
The payment (90%) from the advanced fund received from the consignee shall be released within 15 days of receipt of complete material, survey report and other required documents. Each bill should have clean transport challan showing the stock movement, inspection report of surveyor. Balance 10 % shall be paid after receiving clean acknowledgement from the consignee and payment advice from the consignee and NAFED administrative charges @ 1.50 % plus GST @ 18%. Balance 10% bill should have attachment of proof of consignee acknowledgement of receipt of the goods. Deduction of TDS as per Income Tax/GST Act shall be done at consignee level, certificate shall be issued by consignee in favour of the supplier jute mills/ under intimation to NAFED Kolkata. The 1.50 % administrative charges need to be remitted to NAFED Kolkata before claiming 10% payment.

K.	Procedure for Evaluating the e-Tender:

a. F.O.R RATE rates are to be filled in proper place of e-Tender portal conducted by M/s. MSTC. For the purpose of evaluation bid, final F.O.R RATE rates per 100 bags, exclusive of GST shall be considered whereas the payment shall be made as per the final F.O.R RATE rates per 100 bags, inclusive of all taxes. Branch will undertake financial and technical evaluation of M/s. MSTC of bids invited by the M/s. MSTC. 
b. The jute mills participating in the e-Tender should assess their mill capacity and submit their quantity bid accordingly. If any jute mill would provide their supply quantity beyond capacity; then they will be terminated from the technical evaluation round itself.
L.	Validity of Offer:
Offer (BID) shall be valid for a period of 90 days from the date of opening of e-Tender during which no escalation in the rates will be allowed. The demand of the gunny bags for PSS procurement may be so high that if the L1 party is not in a position to supply the entire quantity, NAFED can negotiate with other participants to supply the gunny bags as per e-Tender terms & conditions at L1 rate if they are interested to do so and accordingly work orders will be issued to them.

M.        Indemnity:
The jute millers shall indemnify NAFED and keep indemnified against any loss or damage, claims, compensation, penalty, fine, levies, etc. on account of slackness, deficiency, failure to observe any obligations under the contract, failure to comply with statutory/ mandatory provisions pertaining to the contract by the jute millers in respect of the services provided etc. whatsoever.
N.       Holiday Listing:
The jute millers are expected to adopt the ethics of highest standards and a very high degree of integrity, safety and quality consciousness, commitment and sincerity towards the work undertaken and dealing with NAFED in such matters. Also, while participating in the tender and performing the contracts, Agencies are required to meet certain performance criteria and adherence to the terms and conditions of the tender. NAFED shall have the right to remove from the list of approved / empanelled Agencies or to ban business dealings, if any jute millers has been found to have committed misconduct or fraud or poor performance or anything unethical not expected from a reputed agency. The guidelines and procedures for Holiday Listing as adopted by NAFED and available separately in NAFED website shall be applicable in the context of all tender floated and consequently, all Orders / Contracts / Purchase Orders placed, by NAFED.
O.       Integrity Pact (IP)
Integrity Pact as decided by NAFED has to be signed by the Applicant as per Annexure-II
P.       Applicable law, Jurisdiction and dispute resolution.
1) This e-Tender documents and its terms and conditions shall be constituted and the legal relation between the parties hereto shall be determined and governed accordingly to the laws of Republic of India and only courts at High Court of Kolkata shall have the jurisdiction in all matters arising out of/touching and/or concerning this agreement and parties to this agreement agree to irrevocably submit to the exclusive jurisdiction of those courts for purposes of any such proceeding.

2) All or any disputes arising out or touching upon or in relation to the terms of this agreement including the interpretation and validity of the terms thereof and the respective rights and obligation of the parties shall be settled amicably by mutual discussion falling which the same shall be settled through arbitration. The arbitration proceedings shall be governed by the Arbitration and Conciliation Act of 1996 (as amended up to date) or any other statutory amendments/ modification thereof for the time being in force. The venue of the arbitration shall be at New Delhi, India and language of Arbitration shall be English. In case of arbitration, the cost of Arbitration shall be beared by the both party equally. 

3) Nothing contained in this clause shall prevent the NAFED from seeking interim injunctive relief against the Licensee in the Courts having jurisdiction over the parties.


General Terms and Conditions
1. The empanelled bidder shall have to carefully study and understand the conditions, specification and technical requirement of the bags to be supplied. If Jute mill has any doubt about the meaning of any term, conditions or specification etc., then Jute mill should refer to the Branch Manager, NAFED Kolkata and get clarification before participating e-Tender. 

2. Arrangement for transportation for supply of gunny bags to various State Civil Supply Corporation/ State Level Agencies etc as well as inspection of goods which is to be carried out by recognized inspection house has to be made by the Jute Mills. The Jute Mills has to submit the F.O.R RATE bill. 

3. GST and Clearance Certificate: No manufacturer, who is not registered under the GST Act prevalent in the State, where his business is located, shall participate in e-Tender. The GST No. should be quoted and a GST Certificate from the commercial tax officer of the circle concerned shall be submitted along with the certified copy of Registration Certificate, without which the e-Tender may not be considered.

The e-Tenderer shall not sublet the supply awarded to it to other mills/s.

4. Only Jute Mills are allowed to participate in the e-Tender for supply of Gunny Bag. The successful e-Tenderer shall have to supply the material within the specified time schedule at the time of issuing Purchase Order (PO). In case, he fails to do so, the NAFED shall be at liberty to get the supply from any other agency at the risk and cost of the e-Tenderer. 

5. At the time of filling the e-Tender it is to be ensured by the e-Tenderer that each page has been signed by them, towards its acceptance of terms & condition. 

6. NAFED reserves the right to accept or reject any or all applications without assigning any reason thereof. The issue of this e-Tender document does not in any way commit or otherwise obliges NAFED to proceed with all or any part of e-Tender process. The e-Tender is not the subject of any process of contract or any contractual obligations between NAFED and prospective Mills.

7. In case of extension in the delivery period with liquidated damages, the recovery shall be made on the basis of the following percentages of value of the gunny bags which the e-Tenderer has failed to supply.
a.) (i) Delay up to one fourth period of the prescribed delivery  period		1%
     (ii) Delay exceeding one fourth but not exceeding half of the  		2%
 Prescribed period
(iii) Delay exceeding half but not exceeding three fourth of the		5%
Prescribed period
    (iv) Delay exceeding three fourth of the prescribed period 			10%

b.) Fraction of a day in reckoning period of delay in supplies shall be eliminated, if it is less than half a day. 

c.) The maximum amount of liquidated damages shall be 10% of the contract value plus GST at applicable rate.
		
d.) If the supplier requires extension in time in completion of contractual supply on account of occurrence of any hindrance, he shall apply in writing to the authority, which has placed the supply order, for the same immediately on occurrence of the hindrance but not after the stipulated date of completion of supply. 

e.) Delivery period may be extended with or without liquidated damages if the delay in supply of goods is on account of hindrances beyond the control of the e-Tenderer or any force measure reasons.

8. In case the supply of material is found substandard or not as per the norms, the supplier will lift the stock at his own cost within 7 days. The rejected bags will lie at the risk and cost of the supplier with purchaser.  Losses incurred in this process shall be in supplier account only. 

9. If an e-Tenderer imposes conditions, which is in addition to or in conflict with the conditions mentioned herein, his e-Tender is liable to summarily rejection. In any case none of such conditions will be deemed to have been accepted unless specifically mentioned in the letter of acceptance of e-Tender issued by consignee 

10. The Branch Manager, Kolkata reserves the right to accept or reject any or all e-Tenders partially or fully without assigning any reason thereof. The quantity of supply as mentioned above may be revised as per requirement.

11. If deemed fit, NAFED shall depute its representative for inspection of material at e-Tenderer’s site prior to its dispatch for which the e-Tenderer should have no objection.

12. The dispatch is of time bound supply for which work orders will be issued to L1/ L1 matching Jute mills based on their dispatch performances.

13. The settlement of administrative charges should be cleared by different empanelled jute mills before releasing of 10% payment as per our tender terms & conditions.


Termination Clause:
1. In case the supply of the material is found to be sub-standard or not as per the norms/ specification, it shall be rejected and the PO shall be cancelled by forfeiting EMD/ Security, which shall be acceptable to successful bidder.
2. If the successful e-Tenderer fails to supply the material, NAFED shall be at liberty to arrange the same either by inviting fresh e-Tenders or by any other alternative means, at the risk and cost of the successful e-Tenderer. 
3. In case, the supply is delayed due to some reason or the other, the liquidated damages for delay shall be imposed, that shall be acceptable to e-Tenderer.




















        Ref:							  Date:
To
State Head , 

Sub:  Submission of offer for supply of New Light Weight Jute Sacking Bags (Indian Origin-775 gms) Gunny Bags–reg.
With reference to your advertisement appeared on________in _________for purchase of New Light Weight Jute Sacking Bags 775 gms gunny bags, we are submitting our offer, and agree as under:
1. We are submitting this offer (Proposal) on our own.
2. We agree to abide by the terms and conditions of the e-Tender.
3. We agree to abide this offer for a period of 90 days from the due date _______ fixed for submitting the same and it shall remain binding upon us and may be accepted at any time before the expiry of that period.
4. We understand that NAFED is not bound to accept any or all offer it may receive. 
5. We are enclosing the following :
i. We enclosed herewith P.O./DD No.__________ dated _______ drawn on ..........................,............( Bank Name) for Rs. ___________/- ( Rupees ___________) on account of Earnest Money Deposit, as per terms and condition of offer.
ii. Attested copy of PAN / TIN No./GST No. of the firm / company.
iii. Letter of Authority issued by Firm / Company in favour of the person signing the documents.
iv. Brief profile of the establishment. 

Signature
Name		:
Designation  	:
Seal /Rubber Stamp of the Firm / Company:





( To be uploaded on letter head of Party in the M/s. MSTC portal )

E-TENDER FORM
Annexure-I
E-Tender Form = Rs._______ 				E-Tender Form No. …
(Non-refundable)
Ref:								Date:
To
State Head, 

Sub:  Submission of offer for supply of New Light Weight Jute Sacking Bags (Indian Origin-775 gms) Gunny Bags.
Dear Sir,
	With reference to your advertisement appeared on________in _________for purchase of new Light Weight Jute Sacking Bags775 gms gunny bags, we are submitting our offer, and agree as under:-
Name of the Mills.................................................................................

Rate = F.O.R Rate  
Quantity in Lakhs
1. F.O.R rate: Quotation shall be inclusive of cost of Jute bag, branding charges, transit insurance of goods, statutory taxes, transit cost, inspection, loading & unloading (at godown point), supervision charges, 2nd stage handling charges & NAFED administrative charges.
(Bids to be submitted online in the MSTC e-Portal)
	SL. No
	Gunny Bags
	Qty. to be supplied (No. of bags)
	Basic F.O.R RATE  rates (per 100 bags)

	
	
	
	Before Tax

	1
	RAJASTHAN
	 
	

	2
	GUJRAT
	
	

	3
	MADHYA PRADESH
	
	

	4
	HARYANA
	
	

	5
	ASSAM
	
	

	6
	UTTAR PRADESH
	
	 

	7
	Karnataka
	
	


 

	







Enclosed please find herewith P.O./DD No.__________ dated _______ drawn on .......................................
(Bank Name) for Rs. 5000/- (Rupees Five Thousand only) + GST @ 18% towards cost of e-Tender Form.

Thanking you,                                                                                      
                                         Yours faithfully,

                                                                                             Name:
                                    Designation:
                                                                                             Seal / Rubber Stamp of the Firm/ Company













Annexure- II
INTEGRITY PACT
National Agricultural Cooperative Marketing Federation of India Ltd. (NAFED), an apex level Co-operative Marketing Federation, registered under the provisions of Multi State Cooperative Societies Act, 2002 (as amended up to date), having its Head Office at Nafed House, Siddhartha Enclave, Ashram Chowk, New Delhi-110014 through ................. (hereinafter referred to as the “The Principal”, as the context may require or admit, which expression shall, unless excluded by or repugnant to the subject or context or meaning thereof, be deemed to mean and include its representatives, nominees, affiliates, successors and permitted assigns) of the ONE PART And a Proprietorship firm or a Cooperative organization or a Partnership firm duly registered under the provisions of Indian Partnership Act of 1932 or a Company registered under the relevant provisions of Companies Act of 1956 or 2013 (In case of Partnership Firm, the intending bidders shall submit a self-attested copy of partnership deed along with authorization in favour of signatory of the bidder documents, while in case of a Company, the Intending Bidder shall submit Certificate of Incorporation, Memorandum of Articles of Association and a Board Resolution in favour of authorized signatory, duly certified by a Company Secretary) through its Director/Partner/Proprietor Mr./Mrs. ___________________ and having its registered office at___________ (hereinafter referred to as "Vendor/Bidder/Contractor") which expression shall, unless repugnant or contrary to the context or meaning thereof, be deemed to mean and include its successors, authorized signatories and permitted assigns) of the OTHER PART
PREAMBLE
A. The Principal intends to award, under laid down organizational procedures, contract/s for …………………………………….. The Principal values full compliance with all relevant laws of the land, rules, regulations, economic use of resources and of fairness/transparency in its relations with its Bidder(s) and/or Contractor (s).

B. In order to achieve these goals, the Principal will appoint Independent External Monitors (IEMs) to monitor the tender process and the execution of the contract with the bidders/contractors/vendors for compliance with the principles mentioned in this Integrity Pact.
Article 1 – Commitments of the Principal
1. The Principal commits itself to take all measures necessary to prevent corruption and to observe the following principles:-

a) No employee of the Principal, personally or through family members, will in connection with the tender for, or the execution of a contract, demand; take a promise for or accept, for self or third person, any material or immaterial benefit which the person is not legally entitled to.

b) The Principal will, during the tender process treat all Bidder (s) with equity and reason. The Principal will in particular, before and during the tender process, provide to all Bidder(s) the same information and will not provide to any Bidder(s) confidential/additional information through which the Bidder(s) could obtain an unfair advantage in relation to the tender process or the contract execution.

c) The Principal will exclude from the process all known prejudiced persons.

2. If the Principal obtains information on the conduct of any of its employees which is a criminal offence under the IPC/PC Act, or if there be a substantive suspicion in this regard, the Principal will inform the Chief Vigilance Officer and in addition can initiate disciplinary actions.
Article 2 – Commitments of the bidder (s) / Contractor(s)
1. [bookmark: page43]The Bidder(s)/Contractor(s)/Vendor(s) commit themselves to take all measures necessary to prevent corruption. The Bidder(s)/Contractor(s) /Vendor(s) commit themselves to observe the following principles while participating in the tender process and during the contract execution.

a) The Bidder(s)/Contractor(s)/Vendor(s) will not, directly or through any other person or firm, offer, promise or give to any of the Principal’s employees involved in the tender process or the execution of the contract or to any third person any material or other benefit which he/she is not legally entitled to, in order to obtain in exchange any advantage of any kind whatsoever during the tender process or during the execution of the contract.

b) The Bidder(s)/Contractor(s)/Vendor(s) will not enter with other Bidders into any undisclosed agreements or understanding, whether formal or informal. This applies in particular to prices, specifications, certifications, subsidiary contracts, submission or non-submission of bids or any other actions to restrict competitiveness or to introduce cartelisation in the bidding process.

c) The Bidder(s)/Contractor(s)/Vendor(s) will not commit any offence under the relevant IPC/PC Act; further the Bidder(s)/Contractor(s) will not use improperly, for purposes of competition or personal gain, or pass on to others, any information or document provided by the Principal as part of the business relationship, regarding plans, technical proposals and business details, including information contained or transmitted electronically.

d) The Bidder(s)/Contractor(s)/Vendor(s) of foreign origin shall disclose the name and address of the Agents/representatives in India, if any. Similarly the Bidder(s)/Contractor(s) of Indian Nationality shall furnish the name and address of the foreign principals, if any. Further details of Indian Agents of Foreign Suppliers shall be disclosed by the Bidder(s)/Contractor(s)/Vendors. Further, all the payments made to the Indian agent/representative have to be in Indian Rupees only.

e) The Bidder(s)/Contractor(s)/Vendor(s) while presenting their bid, will disclose any and all payments made, are committed to or intend to make to agents, brokers or any other intermediaries in connection with the award of the contract.

f) Bidder(s)/Contractor(s)/ Vendor(s) who have signed the Integrity Pact shall not approach the Courts while representing the matter to IEMs and shall wait for their decision in the matter.

2. The Bidder(s)/Contractor(s)/Vendor(s) will not instigate their persons to commit offences outlined above or be an accessory to such offences.

Article: 3 – Disqualification from tender process and exclusion from future contracts

If the Bidder(s)/Contractor(s)/Vendor(s), before award or during execution has committed a transgression through a violation of Article 2, above or in any other form such as to put their reliability or credibility in question, the Principal is entitled to disqualify the Bidder(s)/Contractor(s) from the tender process or take action as per the laid down procedure.
Article: 4 – Compensation for Damages
1. If the Principal has disqualified the Bidder(s) from the tender process prior to the award according to Article 3, the Principal is entitled to demand and recover the damages equivalent to Earnest Money Deposit/Bid Security.

2. [bookmark: page44]If the Principal has terminated the contract according to Article 3, or if the Principal is entitled to terminate the contract according to Article 3, the Principal shall be entitled to demand and recover from the Contractor/vendor liquidated damages of the Contract value or the amount equivalent to Performance Bank Guarantee, whichever is higher.
Article: 5 – Previous transgression
1. The Bidder declares that no previous transgressions occurred in the last three years with any other firm/Company/organization in any country conforming to the anti-corruption approach or with any Public Sector Enterprise in India that could justify its exclusion from the tender process.

2. If the Bidder makes incorrect statement on this subject, he can be disqualified from the tender process or action can be taken as per the procedure mentioned in “Guidelines on Banking of business dealings”.
Article: 6-Equal treatment of all Bidders / Contractors /Subcontractors
1. In case of Sub-contracting, the Principal Contractor shall take the responsibility of the adoption of Integrity Pact by the Subcontractor.

2. The principal will enter into agreements with identical conditions as this one with all Bidders and Contractors.

3. The Principal will disqualify from the tender process all bidders who do not sign this Pact or violate its provisions.

Article: 7 - Criminal charges against violating Bidder(s) / Contractor(s) / Subcontractor(s) If the Principal obtains knowledge of conduct of a Bidder, Contractor or subcontractor, or if an employee or a representative or an associate of a Bidder, Contractor or Subcontractor which constitutes corruption, or if the Principal has substantive suspicion in this regard, the Principal will inform the same to the Chief Vigilance Officer.
Article: 8 - Independent External Monitor

1. The Principal appoints competent and credible Independent External Monitor for this Pact after approval by Central Vigilance Commission. The task of the Monitor is to review independently and objectively, whether and to what extent the parties comply with the obligations under this Integrity Pact.

2. The Monitor is not subject to instructions by the representatives of the parties and performs his/her functions neutrally and independently. The Monitor would have access to all Contract documents, whenever required. It will be obligatory to him /her to treat the information and documents of the Bidders / Contractors as confidential. He /she will report to the Managing Director, Nafed.

3. The Bidder(s)/ Contractor(s) accepts that the Monitor has the right to access without restriction to all Project documentation of the Principal including that provided by the Contractor will also grant the Monitor, upon his/her request and demonstration of a valid interest, unrestricted and unconditional access to their project documentation. The same is also applicable to Sub- contractors.

4. The Monitor is under contractual obligation to treat the information and documents of the Bidder(s)/ Sub-contractor(s) with confidentiality. The Monitor has also signed declarations on ‘Non- Disclosure of confidential Information’ and of ‘Absence of Conflict of interest ‘. In case of any conflict of interest arising out at a later date, IEM shall inform the Managing Director, Nafed and recues himself/herself from that case.

5. [bookmark: page45]The Principal will provide to the Monitor sufficient information about all the meetings among the parties related to the Project provided such meetings could have any impact on the contractual relations between the Principal and the Contractor. The parties offer to the Monitor the option to participate in such meetings.

6. As soon as the Monitor notices, or believes to notice, violation of this agreement, he/she will so inform the management to discontinue or take corrective action, or to take relevant action. The monitor can in this regard submit non-binding recommendations. Beyond this, the Monitor has no right to demand from the parties that they act in a specific manner, refrain from action or tolerate action.

7. The Monitor will submit a written report to the Managing Director, Nafed within 8 to 10 weeks from the date of reference or intimations to him by the Principal and, should the occasion arise, submit proposals for correcting problematic situations.

8. If the Monitor has reported to the Managing Director, Nafed, a substantiated suspicion of an offence under relevant IPC/PC Act, and the Managing Director, Nafed has not, within the reasonable time taken visible action to proceed against such offence or reported it to the Chief Vigilance Officer, the Monitor may also transmit this information directly to the Central Vigilance Commissioners.

9. The word “Monitor” would include both singular and plural.
Article 9 – Pact duration
1. This pact begins when both parties have legally signed it. It expires for the Contractor 12 months after the last payment under the contract, and for all other Bidders 6 months after the contract has been awarded. Any violation of the same would entail disqualification of the bidders and exclusion from future business dealings.

2. If any claim is made/lodged during this time, the same shall be binding and continue to be valid despite the lapse of this pact as specified above, unless it is discharged/determined by the Managing Director, Nafed.


Article 10 : Other Provisions
1. This agreement is subject to Indian Law. Place of performance and jurisdiction is the Registered Office of the Principal, i.e. New Delhi.

2. Changes and supplements as well as termination notices need to be made in writing.

3. If the jute miller is a partnership or a consortium, this agreement must be signed by all partners or consortium members.

4. Should one or several provisions of this Integrity Pact turn out to be invalid, the remainder of this agreement remains valid. In this case, the parties will strive to come to an agreement to their original intentions.

5. Issues like Warranty/Guarantee etc. shall be outside the purview of IEMs.

6. In the event of any contradiction between the Integrity Pact and its Annexure, the Clause in the Integrity Pact will prevail.

I 
(For & on behalf of the Principal)				(For & on behalf of bidder/Contractor)
(Office Seal)							 (Office Seal)
Place: 	_ 
Date 	_ 
Witness 1: 
(Name & Address) 	
Witness 2: 
(Name & Address) 

__________________________________________________________________________________________
NATIONAL AGRICULTURAL COOPERATIVE MARKETING FEDERATION OF INDIA LTD.
20-B, ABDUL HAMID STREET, 2nd FLOOR, KOLKATA-700069
Tel- 033-22483729,22316365 FAX- 22107408. E-mail- nafkol@nafed-india.com; nafedkolkata@gmail.com , Web:- www.nafed-india.com; Twitter: @nafedindia
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